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Thank you for buying MODZILLA.
Have fun.

Getting Started

To use MODZILLA you need -

> Apple Il (with 64K, disk drive and monitor)
Passport (or compatible) MIDI interface

Two MIDI cables

Roland Juno-106 synthesizer

Joystick or KoalaPad

(We highly recommend a good joystick with
selectable non-centering for accurate and easy
control. Our favorite is the C H Products Mach Il
which has a push button on the stick's top for
convenient one-handed use.)
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Make and use a backup copy --

Use any ProDos copy utility to backup the
MODZILLA disk.

As a matter of principle, MODZILLA is not, and will
not be, copy-protected. Please make copies solely
for your own use.

Make a data disk --

There is very little extra room on the MODZILLA
disk. You will need a disk formatted with ProDos in
order to save your sound groups.

MIDI it all together --

With the power cord of your Apple unplugged,
open the top of the computer and insert the MIDI
interface into slot 2 (MODZILLA will only work with
the card in slot 2). Connect the IN of your MIDI card
to the OUT on the Juno, and the OUT of your MIDI
card to the IN on the Juno.

On the back of the Juno, next to the MIDI jacks, is
a switch labeled FUNCTION. Make sure that this




switch is set to position Ill; otherwise, the Juno is
unable to transmit and receive the system-exclusive
data which is vital to MODZILLA's operation.

Startitup -

MODZILLA looks best on a monochrome monitor.
It you are using a color monitor, turn the color control
all the way down.

Place the MODZILLA disk into drive 1 and turn on
the power. Once MODZILLA has finished loading,
the first thing it will ask you is: "Please send a preset
from the Juno."

Whenever a MODZILLA paich is cleared, as it is
when you start, MODZILLA needs to know the
position of all the Juno sliders. Because there is no
way for MODZILLA to ask the Juno for these
positions, it is up to you to push one of the blue
patch/bank buttons or the manual button on the Juno.
When MODZILLA receives the preset, it will display
the preset number in the upper right corner of the
screen.

If at any time after sending MODZILLA a preset
you physically change a parameter on the Juno, a
small black box will appear next to the preset
number. This lets you know that you have altered the
original Juno preset.

If MODZILLA continues asking for a preset after
you have pressed a patch/bank button, there is a
problem in the MIDI connection. MODZILLA will do
nothing _until a preset from the Juno is successfully

The Modules

received. Check the FUNCTION switch on the Juno
to see that it is set to Ill. Turn off the Apple's power,
and check the MIDI interface and cables.

When your Juno is successfully being modulated
by MODZILLA, the preset edit LED's will light in the
Juno's display.

Along the bottom of the screen there are four
boxes, each with its own letter: A, B, C and D. These
are MODZILLA's modulation generators or LFO's.
We refer to them as modules. This collection of four
modules, along with a few other parameters, are what
make up a patch. Eight patches make a group.

Only a single module's parameters can be active
for editing at any one time. To choose the module
you want to edit, move the cursor over any part of that
module and press (click) the button. The identifying
letter of the selected module will be highlighted.

Waves --

Below the identifying letter in each module is that
module's wave icon. To change the wave, move the
cursor to the wave selection area above modules A
and B. Clicking highlights the wave icon under the
cursor and moves that wave into the selected
module.

In the wave selection area, there are sixteen
different waves from which to choose.  The four
numbered waves on the left are the library waves,
which you can load from the MODZILLA disk. Next to
them are the random waves, and finally there are the
standard waveforms with their inverted complements.
(from left to right: sine, triangle, sawtooth, square and
pulse).
~ Each of the standard waves can be doubled in
frequency by clicking on the x2 box. This control is a
toggle between normal and doubled frequency of a
wave. When a wave is doubled, a small "x" appears
under its icon in the module. The library and random
waves cannot be doubled.




Pulse Width Slider -

To the right of the wave selection area is a slider
labeled PW. This slider controls the width of the
pulse wave (the last wave on the right). To change
the pulse width, click at any position in the PW
slider's box. The cursor will disappear and be
replaced with the slider, which can be positioned
anywhere within its range as long as you hold the
button down. When the button is released, the PW
slider is locked into place and the cursor reappears.

Juno Sliders --

To the right of the wave icon in each module there
are two windows. These windows hold either one or
two Juno sliders for that module. To choose which of
the sixteen Juno voice parameters will be modulated,
move the cursor to the Juno slider selection area
near the top of the screen (just below the menu bar).
Clicking highlights the  Juno slider name under the
cursor and moves that name into the right side
window of the selected module.

If there is already one Juno slider name in the
module, it will be moved to the left side window. If
there are two Juno sliders already chosen, the one
on the left is replaced by the one on the right. The
one on the right is replaced by the newly selected
Juno slider.

If you want to replace two sliders with one,
double click on that Juno slider.

Pitch Bend -~

The far left icon in the Juno slider selection area
represents the Juno's pitch bend lever.

lts control by MODZILLA is similar to the Juno's
sliders except that the maximum amplitude of
modulation (depth) must be set with the bend sens.

sliders (located directly above the pitch bend lever on
the Junoj. For most uses, it is a good idea to set the
DCO depth to 10 and the VCF depth to 0.

Sliders vs. Switches --

There are two types of parameter controls on the
Juno: sliders and switches. MODZILLA only
concerns itself with the modulation of sliders. This
means that the chorus, range, HPF and other
switches cannot be modulated by MODZILLA.

In order to obtain the most pleasure from
MODZILLA, a working knowledge of all the Juno's
parameters is essential. Spend time with your
instrument. There is no other way to learn it.

The Control Panel -

Directly above modules C and D is the control
panel. All of the numeric information for each module
is entered from this area of the screen.

In the lower left corner of the control panel are the
letters A, B, C and D. By clicking on any letter, the
corresponding module is selected for editing.

Along the top of the control panel are the
abbreviations RTE, DEL, ATK and AMP. Clicking on
any of these chooses the corresponding parameter
within that module.

To change a parameter's value, click in the
control panel slider box. The cursor will become the
slider, allowing you to change the number. To
increment or decrement the parameter by one, use
the arrows on the control panel's lower right.

The current parameter's value is displayed next to
its name in the currently selected module and in the
bottom center of the control panel. All of the
parameters have a range of values from zero to
ninety-nine.



Rate (RTE) --

The rate parameter controls the modulation
speed of that module. The range is from one, which
takes almost twenty-one minutes to cycle through a
waveform, to ninety-nine, which cycles through the
wave approximately ten times per second (10Hz). A
setting of zero stops the module.

Numbers below thirty take over one minute to
complete a wave. This is useful to keep in mind if a
module does not seem to be doing anything. It is
possible to set up the four modules, each with a
different rate below ten, so that it will take months to
complete a phase cycle!

Delay (DEL) --

The delay controls the time lapse between
resetting a module and the beginning of actual
modulation. The range is from zero (no delay) to
ninety-nine (delay over twenty seconds).

Attack (ATK) -

Once a module has been reset, and the delay
time has passed, the attack determines the time it will
take for the full modulation depth to be realized.

A setting of zero indicates an immediate attack.
Higher numbers will cause a slower attack. If you set
the attack to ninety-nine, the module can take more
than three minutes to reach the full depth of
modulation as set by the amplitude.

Amplitude (AMP) -

The amplitude setting of each module determines
the maximum depth of modulation for the Juno
slider(s) chosen. Set to ninety-nine, the module has
the greatest depth. A setting of zero effectively turns
off the module.

The actual range of modulation is determined by
this setting and the real position of the Juno slider
being modulated. MODZILLA uses the real position
of the Juno slider as the zeropoint for the modulating
wave. For example, if you are modulating the sub
oscillator (SUB) with a sine wave at a full amplitude
of ninety-nine, and the real position (zeropoint) of the
sub oscillator slider is all the way up (a setting of 10
on the Juno), MODZILLA cannot "move" the slider
any higher; therefore you will only hear the
down-slope half of the sine wave affecting the sub
oscillator.

Loop/One-Shot switch --

In the top right corner of each module is the
loop/one-shot switch.  This switch determines the
effect of a reset upon a module. (see Change Resets
on page 14)

When a module is in loop mode, resetting will
start modulation at the beginning of its wave and
continue through its wave cycle.

When a module is in one-shot mode, resetting will
start modulation at the beginning of its wave, go
through to the end of one wave cycle, stop
modulating, and wait to be reset. If the module's
wave is doubled with the x2 function, you will hear
two cycles of that wave.

When the switch is an oval, the module is in loop
mode. If it is a line, then the module is in one-shot
mode. To change between modes, simply click on the
switch. It will toggle between loop and one-shot.



The Pull Down Menus

File Menu

The File Menu contains the disk functions to save
a group of patches, load a group of patches and load
library waveforms.  The quit option is also in this
menu.

What's in a group --
> eight patches
> up to four library waves

Save Group --

To save a group to disk, open the File Menu by
moving the cursor to the word "File" on the menu bar
at the top of the screen. Press and hold the button to
open the menu. Dragging the cursor with the button
held down will highlight the different menu options.
Move the cursor to Save Group and reiease the
button. The Save Group window will open.

Whenever a disk function window is opened, the
first thing MODZILLA does is to check all connected
disk drives for ProDos volumes. To speed up this
process, we recommend that you place a disk in
every disk drive in your system, otherwise ProDos
can take up to ten seconds to determine that a drive
is empty.

All of the available volume names will appear on
the left side of the window. If the volume you wish to
save your group to is not in a drive when you choose
Save Group, place the disk in any drive and click on
Get volumes.

Next, give your group a name. When the cursor is
blinking on the top line of the window, enter in a
twelve-character name with the Apple keyboard.

(Only letters, numbers and the period are allowed in
group names.) Use the delete key or left arrow key to
erase characters from the name. The escape key will
take you back to the original name.

When you have the name you want, either press
Return, click on Save group, or click on the name of
the ProDos volume you want to save to. An arrow will
appear to the right of the selected volume and an OK
capsule will appear in the lower right corner of the
window. To change the volume, click on the new
volume's name.

Clicking on QK will save your group. Clicking on
the Cancel capsule will close the window without
saving the group.

Load Group -

To load a group from disk, choose Load Group
from the File Menu. When MODZILLA presents you
with the online volumes, choose the volume you wish
to load from by clicking on its name.

After clicking QK, the volume name will be moved
to the top right of the window, and all the available
groups in that volume will be listed on the left side.

If there are more than eight groups available, the
scroll bar that separates the two halves of the window
is shaded. Use the arrows at the top and bottom of
the bar to move through the list of group names. The
scroll bar itself has not yet been implemented.

When the group you want to load appears in the
window, click on its name. An arrow will appear to
the right of the name, indicating which group is to be
loaded.

Clicking on QK will load your group. Clicking on
the Cancel capsule will close the window without
loading the group.

When you load a new group, it replaces the group




previously in memory. The edit buffer is not
destroyed. (see The edit buffer on page 12)

The edit buffer can be used to move patches
between groups. First place the patch you want to
move into the edit buffer. Then load the group you
want it moved to and save the patch to that group.

Note:  Because library waves are saved and
loaded with a group, a patch in the edit buffer that
uses one or more library waves will probably sound
different when a new group is loaded.

Volume RAM -

If you are using an Apple //e with an extended
80-column card, you can save and load groups from
the volume RAM. Groups saved to RAM will be lost
when you quit MODZILLA. Make sure to save any
groups you want to keep onto another volume before
quitting.

Load Wave --

Loading a library wave is exactly like loading a
group, except that you must specify which wave
number (1, 2, 3 or 4) you want to load. You can
change the wave number any time before clicking on
OK. When you are through loading waves, click on
Cancel to exit this window.

When you save a group, any library waves
loaded will be saved with that group.

Quit --

To stop working with MODZILLA, choose Quit
from the File Menu. MODZILLA will ask if you are
sure you want to quit. Click on Yes to quit or No to
return to MODZILLA.

Make sure to save any changes you have made
before quitting.
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Edit Menu

The Edit Menu contains the functions to copy and
paste a module, and to clear a module, patch or

group.

Copy Module / Paste Moduie --

By selecting Copy Module, the currently selected
module is copied into a buffer. It can later be pasted
into any selected module by choosing Paste Module.

Clear Module --
Choosing Clear Module will clear the currently
selected module.

Clear Patch --

Clear Patch is an initialization function for the edit
buffer.

Choosing Clear Patch will bring up a window:
"Are you sure?" Clicking on the YES capsule will
clear all four modules in the buffer, set the pulse
width back to the center, change the resets to first key
down, and set the patch name to its default (Patch n,
where n is the current memory position number).
MODZILLA will then tell you: "Please send a preset
from the Juno." It will do nothing until it receives a
preset.

Clear Group -

Clear Group will warn you of your potential loss,
and ask if you wish to continue before completely
clearing out the eight patches in memory.  Clear
Group does not initialize the edit buffer.
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Patch Menu

The Patch Menu displays the group of eight
MODZILLA patches in memory. At the top of the
menu is the group name, followed by the name of
each patch.

What's in a patch ~

> the four modules

> resets (see Change Resets on page 14)
> position of the pulse wave (PW) slider

> real positions of all the Juno's parameters

The edit buffer -

To play or edit a patch, you must move it from
memory to the edit buffer. To do this, simply open the
Patch Menu and move the cursor to the name of the
patch that you want to play or edit.

If you have not made changes to the patch in the
edit buffer, your new choice will immediately be
placed into the buffer, ready to be played or edited. If
the patch you have chosen to edit has no data,
MODZILLA will ask: "Please send a preset from the
Juno."  MODZILLA will then do nothing until a preset
is received.

Along the left edge of the Patch Menu, there is a
checkmark next to the name of the patch that is
currently in the edit buffer. If you have just loaded a
new group into memory, the checkmark shows the
current memory position, not the name of the patch in
the edit buffer.

Keep/Forget Changes —

Every time you choose a patch from the Patch
Menu, MODZILLA compares the edit buffer to the
patch in the current memory position. If there have
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been any changes, you are presented with the
Keep/Forget Changes window.

Across the top of the window is: "You made
changes to:" and the name of the patch that is
currently in the edit buffer. There is a blinking cursor
to the right of the name. The left half of the window
lists the eight patches in memory, with a checkmark to
the left of the patch you have just chosen in the Patch
Menu.

Choosing the Cancel capsule will take you back
to the edit buffer as if you had never come to this
window.

Forget changes --

To forget any changes you have made click on
Forget changes. An OK capsule will appear.
Clicking on QK will close the window and place the
newiy selected patch into the edit buffer.

Keep changes —

If you like the changes, you can place your new
patch into any of the eight memory positions.

First you have the option of giving the patch a
new name. When the cursor is blinking on the top
line of the window, enter in any twelve-character
name with the Apple keyboard. Use the delete key or
left arrow key to erase characters from the name. The
escape key will take you back to the original name.

When you are happy with the name, either press
Return or click on Keep changes. An arrow will
appear to the right of the current memory position and
an OK capsule will appear in the lower right corner of
the window.

You can store your new patch in any of the eight
memory positions by clicking on the name in that
position.  Holding down the button highlights the
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name of the original patch in that memory position.
When you release the button, your new patch name
will replace the original name and the arrow will
move to show which memory position your new patch
will be saved to.

When your patch is in the correct position, click on
OK. MODZILLA will take the contents of the edit
buffer, place them into the chosen memory position,
close the window, and move the newly selected
patch into the edit buffer.

At any time before clicking on OK, you can click
on the new patch name to change it or click on
Cancel to return to the edit buffer.

Keeping changes only puts your new patch into
the computer's memory. To permanently save your
patches to disk, you must choose Save Group from
the File Menu.

Note: Library waves are not saved with a paich.
They are saved only with a group.

Special Menu

The current version of MODZILLA has two
choices in the Special Menu: Change Resets and
Visualizer.

Change Resets --

The Change Resets option opens up the Reset
window. Within this window it is possible to set up
the reset condition for each individual module, the
pitch bend lever and the Juno sliders. Along the top
of the window are their respective icons.

Each of these can be set to a specific reset
condition as indicated along the left side of the
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window. To change the reset setting, click on the
selector dots.

First key down will reset a module or Juno
parameter whenever all the keys on the Juno
keyboard have been released, and a new key is
pressed.

Any key down will reset a module or Juno
parameter when any key on the Juno is pressed. Any
key down implies first key down.

Trigger will reset a module or Juno parameter
whenever the pitch bend lever (LFO trig) is pushed
forward. Trigger can be chosen either by itself or in
conjunction with one of the key resets.

When No reset is chosen, the module or Juno
parameter will not be reset.

The reset function is most useful when you are
playing the Juno keyboard, rather than putting on the
sustain pedal, sitting back and jamming with
MODZILLA. Special effects can be set up by putting
a module in one-shot mode, and then resetting it with
the trigger.

To exit the Change Resets window, click on either
the OK capsule (to keep your changes) or the Cancel
capsule (to forget changes).

Visualizer --

The Visualizer window lets you see and hear the
real positions of all of the Juno sliders and switches.

In the lower left corner of the window (above the
OK capsule) is a box labeled MODZILLA.  This
toggles MODZILLA modulation on and off.

While viewing the Visualizer window, any
physical movement of the Juno's sliders or switches
is shown. After physically moving a slider on the
Juno, a guide is displayed below that slider to help
you return it to its original position, if desired.
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To exit the Visualizer, click on the OK capsule. It
is not possible to cancel any changes made while the
Visualizer is in use.

The Creation of Wobbler - (a tutorial)

The only way to understand and use the creative
power of MODZILLA is to spend time playing with it. If
you need help getting started, follow along as we
create the patch Wobbler and explain a few of
MODZILLA's possibilities.

Loading Wobblertutor --

If you haven't already, boot MODZILLA and press
a patch/bank button on the Juno. Load in the group
Wobblertutor from the MODZILLA disk. (If you don't
know how to load a group, please read the section on
the File Menu).

From the beginning -

Open the Patch Menu and choose Wobbler 1.
When the Keep/Forget Changes window opens,
select Forget changes and then click on the OK
capsule. MODZILLA will now send the Juno
Wobbler 1, a fairly standard Juno preset. Play a few
notes and chords to familiarize yourself with the
sound.

Set the DCO bend sens. slider (on the Juno,
above the pitch bender) to 10, and set the VCF bend
sens. slider to 0.

Select module A by clicking anywhere in its box.
Move the cursor to the left side of the Juno slider
selection area and click on the pitch bender icon
under the label P B. The icon will appear in the right
side slider window of module A.
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lick on RTE in module A or the control panel and
move the control panel slider to 50. Now click on
AMP and move the slider to 64.

Hold a note down and listen. If you hear a sine
wave (the default wave) modulating the pitch of the
Juno, then you have successfully created Wobbler 2!
If not, make sure the MIDI function switch on the Juno
is set to lll and that your MIDI cables are all in place.

Moving on -

Now select module B, click on the pitch bender
icon, choose a square wave by clicking on its box in
the wave selection area, set the RTE to 82 and set the
AMP to 6. Listen to the Juno.

Whenever the same Juno parameter appears in
more than one module, MODZILLA averages
together all of the waves controlling that parameter.
In this case, the pitch is still being modulated with a
medium rate, high amplitude sine wave, but that
wave is being averaged together with a high rate, low
amplitude square wave creating Wobbler 3 .

The other Wobblers --

in Wobbler 4 we add filter resonance (RES) to
module A, which modulates the resonance with the
same sine wave that is currently controlling the pitch
bender. The RES slider is also placed into module C
with a down sawtooth wave, creating a soft beat.

Wobbler 5 expands upon this with a doubled
pulse wave in module D, controlling the filter ENV
sensitivity and the SUB oscillator at the same rate as
the sawtooth in module C. Module D aiso uses the
attack (ATK) parameter to slowly fade in its effect.
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To hear Wobbler 5, press and hold a key. At first
it sounds exactly like Wobbler 4. After a few seconds,
you should hear module D beginning to make its
presence known.

Wobbler 6 and Wobbler 7 are more variations of
Wobbler 4. Listen to both of them and try to
determine how each module affects the sound.
Notice that in Wobbler 7, modules C and D use the
delay parameter. There are also three waves being
averaged together for the pitch bender.

In Wobbier 8, three of the modules (A, C and D)
are set to one-shot mode. If you open the Change
Resets window from the Special Menu, you will see
that module A is set to reset on First key down, and
modules C and D will reset on both the Any key down
and Trigger conditions. Try playing Wobbler 8 by
holding down a chord and pushing forward the LFO
trigger, or hold a chord with your left hand and play
some notes with your right hand.

Don't stop now -

Al it takes is a willingness to experiment to enjoy
MODZILLA to its fullest. Try everything. Don't be
afraid. At worst, you may get a sound you don't like.
At best you'll have gobs o' fun.

If you have any questions about MODZILLA, feel
free to write. We'll do our best to help solve your
problems, open your creative blocks and make your
world a better place to be.
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Random Waves --

The random waves work a bit differently than
other waves regarding rate.

A rate of 50 is the top speed for random waves.
Any higher value will not change the rate of the wave,
but will change the length of its cycle. This is only
apparent when the module is in one-shot mode.

Visualizer note --

While using the Visualizer you will notice the
occasional inaccuracy of your Juno's sliders. This is
attributable to two causes.

First, when MODZILLA is sending lots of data to
the Juno, the synthesizer is kept so busy changing
parameters that it does not respond as immediately to
physical slider movements.

Second, the sliders on the Juno are mechanical
potentiometers whose positions are converted into
digital information.  Like all mechanical parts, the
sliders become dirty and less accurate with time. The
Visualizer's representation of a slider's position is
precisely where the sound-generating circuitry of the
Juno says it is, which may or may not correspond to
the exact physical slider position.

Aliasing? What aliasing? -

The waves that MODZILLA uses for modulation
are digital. Each one, except for the random wave, is
a table of 256 numbers that describe the waveshape.
More that fifty times each second, MODZILLA
changes the Juno's sliders, using these wavetables
as a quide.
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At faster rates, usually above 85, a phenomenon
called aliasing becomes noticeable. In order for
MODZILLA to have rates up to 10Hz, it is necessary
to skip numbers in the wavetable. This can lead to
some very strange, but potentially musically useful,
waves being generated.

The x2 function alleviates some aliasing in the
standard waveforms by using an alternate wavetable
where the frequency of the wave is doubled.

Have Fun --

One of our favorite ways to use MODZILLA is to
put a footswitch or 1/4 inch plug in the sustain pedal
jack, press a few notes, then sit back and play.

Write and let us know what you are doing with
MODZILLA. Enjoy yourself.

A BIG MODZILLA THANKS TO:

Stephanie Allen -- Steve Arnold -- Donny Blank --
Joanne Bloomfield -- Eric Cleveland -- Bob Cowart
Doug Crockford -- Steve Cummings -- Bill Fancher --

Mike Garvey -- Gypsy the Cat -- Alden Jenks -- Teg
Lenker -- Milt-the-Rat -- Alan Rath -- Bryan Rogers --
Steve Savage -- Tim Schmidt -- Lisa Stouder -- Joe
West -- Steve Wilson
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